
Quick Reference Guide
YearTech® Online

Welcome to Jostens YearTech Online, the easiest way to create a yearbook online. 
Using YearTech Online, on Jostens Yearbook Avenue, you can work on your book 

from anywhere you have a high speed internet connection and an internet browser.

The Basic Steps

Program Requirements
Hardware requirements:
	 •	Windows or Macintosh Operating System

	 •	 Intel Pentium processor 

	 •	Windows 2000, XP, XP Pr, Vista or 7

	 •	Mac OS 10.4 or higher

	 •	256 MB available RAM (512 MB or more recommended)

	 •	Video card with 24-bit, high resolution display
 
Display requirements:

	 •	1024x768 screen resolution or higher 
Internet requirements:

	 •	High-speed Internet required 
Browser requirements:
	 • Windows: Internet Explorer 7.0 and above or Firefox 3.0
 
	 • Mac: Safari 3.1 and above or Firefox 2.0 and above
 
Flash requirements:
	 •	Flash 10 or higher

1.	 Plan your yearbook project (staff, fonts, styles). (pages 3-4)

2.	 Complete your Page Ladder (assign pages, set templates). 
	 (page 7)

3.	 Mail in or upload photos and images for your Image Library. 	
	 (pages 5-6)

4.	 Create your pages. Start from the Page Ladder or Page Designer 	
	 to select a page and edit images and text. (pages 8-13)

5.	 Before submitting, print out page preview(s) to check/review 	
	 your page(s). Once you submit a page, you will no longer be 
	 able to make changes to it. Changes requested after submission 	
	 can result in extra charges. Contact your plant consultant for 	
	 assistance. (page 14)

6.	 Submit your page(s). (page 15)

     Note: Some of these functions are only available to the adviser 	
     and editor login. 

Creating your book using Jostens YearTech 
Online is an easy and enjoyable process. 

This guide outlines the six basic steps (see list to the 
right) involved in creating your yearbook online. You can 
find more detailed information about these steps in the 
online help on your Yearbook Avenue website.

Award-winning Technology: Yearbook Avenue was awarded the Outstanding Achievement Award by Interactive Media Awards    (IMA) for the second straight year. 
Jostens Yearbook Avenue was also awarded a patent by the U.S. Patent and Trademark Office, making it the only patented online yearbook system available today.

TM

www.yearbookavenue.com



Logging In and Using Your Home Page
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Your Home Page is  
customized with  
information pertinent  
to your school and  
your book. You can  
use this page to help  
you track your  
progress throughout  
the year. 

Yearbook Avenue  
is the overall  
comprehensive site  
that provides status  
information, ideas,  
selling tools,  
educational tools  
and planning tools  
for your yearbook.

YearTech Online  
is the creation  
tool that you will  
access through 
Yearbook Avenue.

•	 Enter the Year, your Login ID, Password and 	
	 Job Number. Click Sign In to enter your	
	 website.

•	 Use the menus on the header bar to quickly 	
	 navigate to other areas of your site, 
	 including the Planning and Creating your 	
	 book pages.

•	 The buttons underneath the display window 	
	 on your main page allow you to toggle 
	 between informational windows including a 	
	 Gallery, Page and Staff status; Sales, 
	 Image and Deadline reports; and a Virtual 	
	 Preview of your yearbook. You can also 
	 access online Training here. 

•	 The right-hand column provides a quick 	
	 overview of important details including 
	 Student Coverage, Upcoming Events 	
	 and Messages. 

•	 The Ideas and Tips section along the lower 	
	 portion of your home page provides timely 	
	 hints and information to help you as you 	
	 create your book. 

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

If your school is new to Jostens, you 
will receive your Yearbook Avenue login 
information in an email from Jostens. 
The first time you log in, you will be 
asked to provide contact information 
and change your login and password to 
something you will easily remember.
 
If you used Yearbook Avenue last year, 
your adviser login and password will 
carry over. If you do not have your login 
or password, or are a new adviser 
at your school, please call your plant 
consultant for assistance.



Entering Staff Information and Passwords
•	 Choose Staff from the Plan menu to access your 	
	 Adviser and Staff information.

•	 Click the Chat Enabled box at the bottom of the 	
	 Staff Administration page to enable online chatting 	
	 on your site. 	 	 	 	 	
	 Note: See the online Help section for more 		
	 information.

•	 To add a New Staff member enter their 	 	
	 information.

•	 If Chat is enabled, check the Group/Private Chat 	
	 boxes to allow access to the various Chat 	 	
	 Functionalities.

•	 Check the Inbox Access box to allow access to 	
	 the upload inbox.

•	 Once you have finished,click on the Add button.

•	 Click on the Update button next to an Adviser or 	
	 Staff entry to make changes.

•	 Use the Delete button to remove a staff member.

•	 To view an activity history on any staff member, 		
	 click on the Activity button by their name.

Security and Permissions
Adviser Login:

The adviser login has the highest level of security. 	
This login has access to do everything the editor 	
and staff logins can do, along with the following:

	 •  Select fonts for your book 
	 •  Set styles for your book 
	 •  Enter staff information 
	 •  Create portrait pages (autoflow)
	 •  Lock and unlock pages
	 •  Submit pages
	 •  Set up a yearbook offer
	 •  Enter sales information
	 •  Access selling tools and promotional pieces 	
	 	 on Yearbook Avenue
	 •  Submit personalization information

Editor Login:

The editor login has access to do everything the staff 	
login can do, along with the following: 

	 •	 Set templates for pages
	 •	 Assign pages to staff members
	 •	 Move pages
	 •	 Create an index
	 •  Create portrait pages (auto flow)
	 •  Create index
	 •  View ladder
	 •	 Move photos from Staff inbox to image library
	 	 (if Inbox Access is selected when the Adviser sets up 
	 	 his/her login info)

There are four levels 
of access to the 
site: adviser, editor, 
staff and business 
manager. Each access 
level has a different 
level of security. Here 
is an overview of the 
permissions provided 
with each level.

Staff Login:

The staff login has access to do the following:

	 •  Create/edit pages
	 •  Create portrait pages (auto flow)
	 •  Create index
	 •  View ladder
	 •	 Access Staff inbox to image library
	 	 (if Inbox Access is selected when the Adviser 
	 	 sets up his/her login info)

Business Manager Login:

	 •	 Create an offer using Yearbook Avenue Sell 
	 	 (ItPays) tools
	 •	 Enter sales information
	 •	 Access selling tools and promotional pieces on 	 	
	 	 Yearbook Avenue
	 •	 Set yearbook and advertising sales goals
	 •	 Create an index
	 •	 Move photos from Staff inbox to image library 
	 	 (if Inbox Access is selected when the Adviser 
	 	 sets up his/her login info)
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Advisers can update  
their contact  
information and  
change the password  
for themselves or  
their staff members  
at any time. 

We recommend  
periodically changing 
passwords to help  
maintain site security. 

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.
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Selecting Fonts for Your Book

Setting Styles for Your Book

•	 Use the Plan menu on your header bar to 	
	 access the Fonts page.

•	 Choose fonts to view by selecting from the 	
	 drop-down menus. 

•	 You will see a preview of the currently 	
	 selected font in the Font Preview window.

•	 Click the Add Arrow button to add a font to 	
	 your collection. While in Page Designer you 
	 can also use the Add Fonts button under 	
	 the Format tab to quickly add new fonts.
	
	 Note: When creating your book, your staff 	
	 will only be able to select from the fonts you 	
	 choose for your collection.

•	 Click the Delete button to delete a font from 
	 your collection. 
	 Note: If you delete a font that was already 	
	 used on a page, no changes will be made 	
	 to the page(s) using the font. However, the 	
	 font will not be available for selection on 	
	 new text boxes or pages.
 

The adviser can set 
font styles to use 
in your book on the 
Styles page. You will 
be able to change 
styles on an indi-
vidual page.

Use the Plan menu  
on your header bar  
to access the  
Styles page. 

You can also add 
styles from the Page 
Designer Edit/Styles 
menu.

•	Enter the name of the Style Type you would 	
	 like to create (Headline, Body Text, etc.). 	
	 Then enter the font specifications in the 	
	 Font, Size and Attribute fields.

•	You will see previews of the fonts you have 	
	 selected in the boxes next to the style fields.

•	Click on the Apply Changes button to save 
	 your changes. 

•	To apply a style to a text box, click on the 	
	 box to select it. Then right-click and choose 	
	 the style you would like to apply from the 	
	 pop-up menu (control-click when using 
	 a Mac).

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Prior to creating 
pages, the adviser 
will need to select 
the fonts that will be 
available for use in 
your book.

Use the Plan menu  
on your header  
bar to access the  
Fonts page.

You can also access 
Add Fonts from the 
Format screen in the 
Page Designer when 
text is selected.
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Start by collecting and organizing your photos. 

Categorize your photos into groups that make sense to you. This will make it easier to find your photos on your 	
website when you start creating your book.

Submitting Your Photographs 

Uploading Digital Images
•	 While in the Image Library you can Upload 	
	 new images to the category you are viewing 	
	 by clicking the Upload button. 

•	 In the pop-up window, click Add Files 	
	 and then locate and select the images you 	
	 would like to upload from your computer. 

•	 Use the New button to add additional 
	 categories. to your Image Library. 

•	 Once uploaded, your images will be 
	 available in your Image Library online. 
	 Note: See the next page for more 
	 information on your Image Library.

Digital Image Guidelines:

•	 .JPG, .TIF and .PNG files only

•	 High resolution files. If you are scanning photos, 	
	 use 400–500 dpi.         
	 	 •	 If you are using a digital camera, set it to the 	 	
	 	 	 highest resolution setting.                               
	 	 •	 Camera phones will not provide a quality image.

	 	 •	 Maximum file size is 50 MB.

	 	 •	 RGB file format only (no CMYK).

	 	 •	 Do not alter the resolution of your image in a 	 	
	 	 	 photo editing software program. Doing this may 	 	
	 	 	 allow you to place an image in a larger photo 	 	
	 	 	 box, but it may also result in a poor quality print.

Category and File Naming Guidelines:

•	 Category and File names should be a maximum 	
	 of 20 characters long.

•	 Use only English alphabet letters and numbers. 	
	 Do NOT use any special characters or 	 	
	 punctuation marks in the names.

•	 Do not use any spaces at the beginning or end 	
	 of names.

•	 Do not use the same name on more than one 		
	 category or more than one image. 
	 Make sure they all have unique names 
	 (for example: BBall1.jpg, BBall2.jpg).

Submitting Printed Photographs or Images on CD/DVD

Once you have your photos organized, use the Photo Stickers to label them. Your job number is printed 	
on the top of your Photo Stickers. Using a No. 2 pencil, write the photo category on the sticker. 

Note: To avoid leaving indentations, write on the stickers before you put them on the back of 
your photos. Do not use ink because the ink may bleed onto other photos when mailing.

After you have your photos labeled, fill out your Photo Sorting Envelopes. Print your school name, job 
number, address information, photo category name and number of photos included on each envelope.

Put each group of photos in the appropriate Photo Sorting Envelope and place all of your Photo 	
Sorting Envelopes in a Return Photo Mailer. To address your Photo Mailer, use the address labels 
you received in your yearbook kit or write in the address located under Contact Us on your website. 
Write FINAL on the outside of your photo mailer when you send in your last photo submission. 

If you want your 
portrait photographer 
to submit your 
portrait CD/DVD 
directly to Jostens, 
please complete the 
Portrait Submission 
form and ask the 
photographer to 
include it in the 
shipment.

The Portrait 
Submission Form is 
available under the 
Need Help/Resources 
link online.

(Mail to Jostens)
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Using Your Image Library

Your Image Library 
will help keep your 
images organized 
and store 
information that will 
be used to create 
your index and track 
student coverage.

Use the Create or Go 
To menu to access 
your Image Library.

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

•	 Use the folder display in the Categories 	
	 window to select the images you would like 	
	 to view.
	 Note: 50% of the images uploaded to your 	
	 top-level category folders will be displayed 	
	 on your ReplayIt.com site. You can tell 	
	 which folders will be highlighted on ReplayIt 	
	 by the yellow play button next to the folder 	
	 name. If there is a photo you do not want 	
	 displayed in ReplayIt you can flag it on the 	
	 ReplayIt site and it will be taken down from 	
	 ReplayIt, but will remain in your Image 	
	 Library on Yearbook Avenue. 
 
•	 Thumbnail previews of the images in your 	
	 selected category will appear in the Image 	
	 Library window.

•  Use the Preview Size scroll button to 
	 enlarge or shrink the size of your previews. 	
	 If you have more images than can display at 	
	 one time, the scroll bar along the right hand 	
	 side to move through your thumbnails.

•  While viewing your thumbnails you can 	
	 Rotate them using the Rotate buttons. 
	 You can also Download and Delete images 	
	 from your Image Library. 

•  Use the Search box in the Image Library 	
	 header to search your images. All results 	
	 will be returned in the Image Library 
	 thumbnail window. Use the Filter drop-	
	 down menu to help you narrow down your 	
	 search results.

•  Use the ReplayIt button to go to you 		
	 school’s ReplayIt site. (See page 8 for more 	
	 information on using ReplayIt to help share 	
	 content with your school community.) 

•	 Your images are marked to help you track 	
	 their usage in your book. A Green Check 	
	 Mark on a thumbnail indicates that the 	
	 image that has been used in your book and 	
	 a Red Exclamation Point means the image 	
	 still needs to have name information added. 

•  You can Upload new images to the 	 	
	 category you are viewing by clicking the 	
	 Upload button and selecting the images 	
	 from your computer. 

•	 Use the New button to create a new photo 	
	 category in your Image Library, the Delete 	
	 button to Delete a category, and the Edit 	
	 button to edit the name of a category. 
•	 Use the Preview button to create a PDF of 	
	 all of the photos in a category. 

This year we have made managing your images even easier by including eight categories in your Image Library as sub-folders of 
the top-level Activity folder—Widget, Academics, Clubs and Organizations, Dances and Events, Miscellaneous, Sports, Student Life 
and Ads. These top-level categories can be renamed or deleted, and you can create subfolders under each category to help you 
further organize your photos.
Note: If you had already created categories or uploaded images, the images you uploaded will be moved to a Miscellaneous 
category folder. You can move them into other categories to reorganize them. 



•  Immediately after you upload photos YTO will place    	
    boxes over areas in your photos that it recognizes as 	
    faces. You will see a list of faces with a box that says 	
    “Unknown” to the right of the photo. Click each box 	
    to select a name for each face - matches will appear     	
    at the top of the list and will be highlighted. You may 
    also choose to type in a name, and the list will filter 
    to names matching your typed text. You will not be 	
    able to resize, move or delete the boxes that are 
    placed automatically over faces by YTO.  

•  You can add boxes to faces that were not detected 
     by clicking on a face in the photo. This will add a box 
    similar to auto-detected face boxes. You will be able 
    to resize, move and delete the boxes you add 
    manually. Manual added faces can not be 
    automatically matched against other detected faces.    	
    You can tag the faces with names using the same 	
    process as outlined above. 

•	 If the person you are tagging is not in the list, click on 	
    the + Add button and enter the Name and Grade  	
    information into the appropriate fields. Click OK to add    	
    the name information to your image.

•	 If you need to remove a name from the list, click on 
   	the X button next to the name.

•	 After you have added everyone’s name, click on the   	
   	Details tab and check the Index This Photo box so the   	
	 names will show up in your index if the photo is used 	
	 in your book. 

•	 To add keywords to an image, click on the Details tab 	
	 while viewing the image preview. Enter the Keywords 	
	 you would like associated with the selected photo in 	
	 the Caption field. 
	 Note: Entering information in the Name and Caption 	
	 fields will make finding photos in your Image Library 	
	 easier. And, if you enter accurate name information 	
	 for each photo, you can have YearTech Online create 	
	 your index and coverage report.

• 	Click the Done button to save all of the changes you 	
	 made. 

• 	Use the arrow buttons to move through your images, 	
	 or close the pop up window and return to your Image 	
	 Library. 

Image Tagging and Facial Recognition

Jostens Image
Tagging software 
helps you accurately 
identify everyone in 
your yearbook using 
industry leading 
facial recognition 
technology. 

Combined with 
the power of the 
Coverage Report, 
it will be easier to 
meet your goals 
of making sure 
everyone is in the 
book three times.
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For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Jostens new imaging tagging software helps you accurately identify everyone in your yearbook using industry leading facial 
recognition technology. When you click on a face in a photo, you’ll be provided with suggestions of who that person might be. 

The matches are suggested based on photos you have already tagged, or from the portrait images uploaded to your Image Library.

If no names are suggested, you can begin typing in a name and a list of suggestions will appear. These names will come from the 
student list you upload to your site at the beginning of the year. This process helps eliminate spelling errors since staff members 
are not required to type in names. It also makes name identification more consistent.
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ReplayIt - Setting Up & Promoting Your Site
Replay It is an 
interactive website 
that empowers your 
school community to 
share their collective 
story. 

Usiig Replay It your 
school community  
can share their 
favorite photos with 
you, and view the 
photos your staff and 
other community 
members are 
sharing. It is a great 
way for you to get 
more possible content 
for your yearbook, 
while at the same 
time making your 
school community 
feel more included. 

To set up and promote 
your school’s Replay It 
page select Replay It 
from the Plan menu.

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Setting Up Your ReplayIt Site
•	 Click on the ReplayIt link under the Plan 	
	 menu to access your Replay it set up and 	
	 promotional page. You can also access this 	
	 page by clicking on the Set Up/Promote link 	
	 next to the ReplayIt Inbox in your Image 
	 Library. 

•	 Start by setting up a passcode for your 	
	 ReplayIt site and choosing a school color. 	
	 The school color you choose will be 
	 featured on your ReplayIt site. Click the 	
	 Save Changes button when you are done.

Promoting Your ReplayIt Site
•  We have provided three easy ways for you 	
	 to promote your ReplayIt.com site: email, 	
	 web banners and flyers.

•  When you click on the Email link you will 	
	 be asked what product you would like to 	
	 promote. Choose ReplayIt from the drop-	
	 down menu.

•  If you would also like to promote a yearbook 	
	 offer in the email select it in drop-down two. 
•  In field three enter your school’s name 	
	 exactly as you want it to appear in the email 	
	 and subject line.

•  Click on the Next button and you will see 	
	 a preview of your email. Click Next again 	
	 and you will see a screen where you can 	
	 input your email addresses. 

•  You can enter email addresses manually, 	
	 copy and paste them from a list you have, 	
	 or click on the Address Book link to select 	
	 addresses from the list you uploaded. 

•  Click on the Send button to send your 	
	 email.

•  When you click on the Add a Web Banner link 	
	 you will be asked what product you would like 	
	 to promote. Choose ReplayIt from the list.

• Follow the instructions on the Banner Ads and 	
	 Links page to have the Web Banner added to 	
	 your school’s web site. 

•  When you click on the Send Out A Flyer link 	
	 you will open an editable PDF flyer. 

• Enter your school’s ReplayIt passcode and 	
	 make copies to distribute. 

Promoting Your ReplayIt Site-Email

Promoting Your ReplayIt Site-Web Banners

Promoting Your ReplayIt Site-Flyers



Using Your ReplayIt Site

To get started go to
www.ReplayIt.com!
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For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

•	 The first time anyone tries to access your 	
	 ReplayIt site they will have to create their 	
	 own user name and password. And, if you 	
	 have included a password during your site 	
	 setup (see page 8, Setting Up Your 
	 ReplayIt Site) they will also need to enter 	
	 your school’s assigned password to finish 
	 creating their account.

•	 Once they have logged on, users can 
	 navigate the site using the timeline across 	
	 the top of the page. By repositioning the 	
	 pointer users can move from one time to 	
	 another. 

•	 Widgets point out which categories need 	
	 more pictures. As you can see in the 	
	 example, Morris high school needs debate 	
	 photos. 

•	 Click on an image to enlarge a photo. 

•	 Click on the Upload button to upload and 	
	 share images with your school community. 
 
•	 You will be able to choose photos from your 	
	 computer, Facebook and Flickr.

•	 Take the time to Tag your images and write 	
	 a description before you upload them. Then 	
	 if they get used in the yearbook they’ll be 	
	 easy to index.

	 Note: Each image uploaded by the school 	
	 community will be reviewed for the most 	
	 common offenses such as nudity, gangs 	
	 symbols, guns and other visible issues. 	
	 Images that are found to be offensive will 	
	 not make it to the public ReplayIt site. This 	
	 process takes just a few minutes.
	 In addition, anyone can flag a photo that 	
	 they find offensive and it will be removed 	
	 from the site.



Using Your Page Ladder
You will be able to 
assign up to two staff 
members to a page.  

If you assign staff to  
a page, only the 
assigned staff along 
with the Adviser and 
Editor will be able to  
edit the page. 

If you wish to allow  
editing access to all  
staff, leave pages 
unassigned.

•	 You can plan your book page-by-page. 	
	 Section, Description, Deadline, Staff and 	
	 Page Type can all be edited by clicking on 	
	 them and entering information in the field 	
	 that appears.

•	 Use the Display Range drop-down menu at 	
	 the top of the page to move through the
 	 book in 16-page increments.

•	 The color coding will help you keep track of 
	 individual page status.

•	 Click on the Print All button to print a hard 	
	 copy of your yearbook ladder. 

•	 The Lock All and Unlock All buttons change 	
	 the lock settings throughout the book, while 	
	 the Locks on the thumbnails only affect the 	
	 individual page.

•	 The Adviser login can Hide a page and a 	
	 Top Secret image will appear on the ladder.

•	 Use the Filters and Templates tabs to move 	
	 between ladder functions.

•	 Use the drop-downs under the Filters tab to 	
	 view your pages by Staff, Deadline, Page 	
	 Type, Page Status or Lock Status.

•	 Click on the Save All button to save the 	
	 changes you’ve made to your ladder.

•	 Under the Template tab, use the Template 	
	 drop-down to select a template category.

•	 To place a template, drag it from the 	
	 Templates section and drop it on your 	
	 selected page.

Jostens Page Ladder is a wonderful tool 
to help you organize your yearbook.

Access the Page Ladder under the Plan 
menu, or from the Go To menu while you 
are in your Page Designer.

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

10



Use the Create  
menu to select  
Page Designer. 

Jostens Page 
Designer provides you 
with powerful layout 
tools to help you 
create exciting pages 
for your yearbook. 
Using Page Designer 
you can place and 
crop images, edit 
text, add clip art and 
backgrounds.

We have provided you 
with hundreds of  
pre-designed layout 
templates to help 
make the yearbook 
creation process 
easier. These  
templates can be 
used as-is or  
modified in Page 
Designer. You can 
access these designs 
by clicking on the 
Designs button  
in Page Designer.

Using Your Page Designer
•	 Use the Pages, Designs, Images, Format, 	
	 Flow and History tabs to navigate 
	 option screens while creating your page.

•	 To begin working on a page, click on the 	
	 Pages tab to bring up a thumbnail view of 	
	 the ladder. Click on the thumbnail of the 	
	 page that you would like to work on and it 	
	 will appear in Page Designer. 

•	 Use the Designs, Images and Format 
	 tabs, along with the toolbar and drop-	
	 down menus at the top of the Page 
	 Designer screen to edit your page. 

Basic Tools Overview: 
•	 You can add Ruler Guides by dragging 	
	 them onto your page from the vertical and 	
	 horizontal rulers. Choose Lock Guides from 	
	 the View menu to lock your guides in place. 

•	 To add Column or Row guides, right-click 	
	 on the side or top ruler and select the 	
	 number of columns or rows you would like 	
	 to create.

•	 Use the Keyboard Arrow Keys to nudge 	
	 elements on the page. (The Snap to Grid 	
	 needs to be disabled in order to nudge 	
	 elements by points. If the grid is enabled 	
	 the arrow keys will move the element to 
	 the nearest pica marker, and then in 1/2 	
	 pica increments.)

•	 To align several elements simultaneously, 	
	 hold down the Shift key while you select  	
	 the elements. Then right-click on a 
	 selected item and choose the appropriate	
	 alignment option.

•	 In the Page Designer, go to the Designs tab 	
 	 then use the drop-down menu to select a 	
	 template design category. 

•	 We have added four new sets of Theme 	
	 templates to the Page Surfer designs. You 	
	 can use these Theme Categories to create 	
	 your whole book!

•	 To place a template, drag it from the 		
	 template design thumbnails section and 	
	 drop it on your selected page.

•	 You can save your page layouts as 	 	
	 templates so that you can use the designs 	
	 on other pages. To save a page as a 	
	 template simply choose Save as Template 	
	 under the file menu.

•	 Once you have saved your page as a 	
	 template you can access it in the 	 	
	 Custom/My Templates Design category.

Using Jostens Pre-Designed Templates

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.
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Placing Images

Placing Text

•	 Click on the Images tab in Page 
	 Designer to access the available images. 

•	 Use the Images drop-down menu to select 	
	 an image category. Jostens clip art is listed 	
	 by category under the clip art header in the 	
	 drop-down menu. Photos you submitted 	
	 will be in the Activity or Portrait sections.

•	 When you use the Search button the 		
	 returned images will appear in the image 	
	 column. 

•	 To place an image, drag it from the Image 	
	 thumbnails section and drop it on the photo 	
	 box you would like it placed in. You can 	
	 also drag and drop an image onto your 	
	 page without placing it into an existing 	
	 photo box.

•	 Double-Click on the image in the box. 
	 A zoom scroll bar will appear along the top 	
	 of your image. Use this bar to resize the 	
	 selected image. While the image is selected 	
	 you can also use your mouse to move the 	
	 image around in the box to change the	
	 cropping area.

•	 To move an image box, click on the box 	
	 until your cursor becomes a 4-sided arrow. 	
	 Then use your mouse to reposition the 	
	 image box.

•	 Enlarge your Page View using the drop-	
	 down menu so that you will be able to see 	
	 the text on your monitor as you edit it.

•	 Choose the text box you would like to edit 	
	 by selecting it with your mouse or click on 	
	 the Place New Text Box button on the tool 	
	 bar to add a new text box. 
	 Highlight and delete the default text and 	
	 enter your own text.

•	 Use the Format tab to change the font 
	 attributes and alignment for your text. There 	
	 are many options to choose from including:
	 - Knockout Text
	 - Text Wrap
	 - Drop Shadow
	 - Line Spacing
	 To learn more about using these tools, use 	
	 the Need Help menu on Yearbook Avenue.

•	 You can also change the attributes and style 	
	 of a text box by right clicking on the text box 	
	 and choosing from the pop-up menu.

•	 To move a text box, click on the edge until 	
	 your cursor becomes a 4-sided arrow. Then 
	 use your mouse to reposition the text box.  

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.
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For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

There are some 
exciting Photo Effects 
available in the 
YearTech Online Page 
Designer. You can use 
Page Designer to:

- Adjust tint and    		
   transparency
- Add drop shadows
- Change shapes
- Make photo     		
   backgrounds
- Create rounded 		
   corners
- Remove red eye
- Rotate photos

Access the effects by 
selecting the Format 
tab in Page Designer.

Cut Out Backgrounds
•	 To make a Cut Out Background, select the 	
	 image you would like to edit and then click 	
	 on the Cut Out Background icon in the 	
	 Format/Effects toolbar. 

•	 Use the Cut Out Background Eraser tool to 	
	 erase the area you would like to remove 	
	 from your image. Use the buttons at the 
	 bottom of the window to change the 		
	 Eraser from circle to square shape, and 	
	 use the Radius scroll line to change 		
	 the size of your Eraser. 

•	 If you erase an area and decide you want it 	
	 back you can use the Undo Arrow button. 
	 You can also use the Paintbrush to paint 	
	 an area back in that you previously erased. 

•	 You will want to Zoom in on your image to 	
	 make editing easier. When you are Zoomed 	
	 in you can use the Hand tool to reposition 	
	 your image in the editing window. 

•	 Once you finish your image click Apply to 	
	 apply the image edits to your page. 

Selective Color
•	 While in Page Designer, select the photo 	
	 you want to edit. 

•	 With the image selected,click on the 		
	 Format tab, and then select the Effects link 	
	 at the top of the Format window. 

•	 Click on the Selective Color button. 

•	 Use the Selective Color Brush tool to add 	
	 color back to areas of your image. Use 	
	 the buttons at the bottom of the window to 	
	 change the Brush from a circle to a square 	
	 shape, and use the Radius scroll line to 	
	 change the size of your Brush.

•	 If you paint an area and decide you don’t 	
	 want it colored you can use the Undo 	
	 Arrow button. You can also use the Eraser 	
	 to erase the color you added to an area.

•	 You will want to Zoom in on your image to 	
	 make editing easier. When you are Zoomed 	
	 in you can use the Hand tool to reposition 	
	 your image in the editing window. 

•	 When you finish your image click Apply to 	
	 apply the image edits to your page. 
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Portrait Panel Pages, Getting Your Images Ready

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

•	 If you need to move a person from one 	
	 portrait category to another you can do so 	
	 by clicking on their image thumbnail and 	
	 dragging their image to another category.

•	 You can change a person’s name by 		
	 double-clicking on the portrait thumbnail and 	
	 clicking the edit button next to their name.

•	 Use the Use Portrait drop-down menu to 	
	 choose whether to use the portrait or “no 	
	 photo” artwork. 

•	 Use the Use Portrait drop-down menu 	
	 to tag an image as Teacher, Assistant, 	
	 Student or Other. Portraits will place 
	 alphabetically within each portrait type 
	 category, and the categories will place 	
	 in the following order: Teacher, Assistant 	
	 Teacher, Student, Other.

•	 Use the Delete Image button to remove an 	
	 entry.
	 Note: We recommend against deleting 
	 images in case you decide to use them 	
	 later, instead select “Don’t Use Portrait.”

•	 If you select the Index This Photo option, 	
	 all the information in the Names field will be 	
	 included in the Index. 	
	 Note: If you do not want an entry to appear 	
	 in the index, uncheck this box.

•	 Click Done to save your changes to the 	
	 portrait record.

If you decide to create your portrait pages using the auto flow functionality available in the YearTech Online Page Designer, 
follow these steps:

1.  Submit your portrait CD to Jostens in the Portrait CD mailer included in your yearbook kit, or submit your portraits in 		
     Photo Sorting Envelopes for Jostens to scan and upload to your site.
2.  Edit your student image information in the Image Library. Then print out a category preview to create your own “photo    	
     proofs” to edit. Enter all changes into the Image Library BEFORE you flow your pages.	
3.  Auto flow your portrait categories into your book.
4.  Make all corrections in the Image Library. This will ensure that the edited information shows up correctly when you 		
     create your Index. 

Proofing Tips:
If you need assistance from classroom teachers or others to review the portrait information and provide feedback you 
can print out category previews by clicking on the PDF button in the Image Library. Then enter all changes into the Image 
Library before you flow your pages.

Before you flow 
your panel pages, 
it is important that 
you edit the “No 
Grade” category in 
the Image Library. 
If you do not 
redistribute these 
photos to the 
appropriate category 
before you flow 
your pages, the 
photos will not 
appear in your book.
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For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Portrait Panel Pages, Creating Your Pages
•  Go to the page you would like to edit in 	
	 Page Designer. 	 	

•  Click on the Designs tab.

•	 Choose the Page Surfer link at the top of 	
	 the Designs window and select Portraits 	
	 from the drop-down menu.

•	 Drag the template design you would like to 	
	 use onto your page.
	 Note: You also have the option to design 	
	 your own portrait page layout and use the 	
	 steps listed below to flow portraits into your 	
	 custom layout.

•  Select your name formatting style you 	
	 would like to use from the Format drop-	
	 down menu. 

•	 Choose the grade that you would like to 	
	 flow from the drop-down menu.

•	 Click the Flow button.

•	 After you Flow your pages, you can edit 	
	 your pages in Page Designer.
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Coverage Report

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

The Yearbook 
Coverage Report 
makes it easy for 
staffs to track the 
number of times a 
student appears in a 
yearbook. The report 
also ties to your 
online selling tools, 
so you can use it to 
see which students 
are in the book but 
have not yet pur-
chased a book. This 
provides you with a 
great way to target 
prospective buyers.

•	 Access your Yearbook Coverage Report by clicking 	
	 on the Coverage Report link under the Create or 	
	 Go To menu.

•	 Your Coverage Report default sort will be 		
	 alphabetical by Last Name. Click on any report 	
	 header to change the sort. 

•	 You can use the Coverage Report tools to Add 	
	 a Name, Import Last Year’s Consumers, Import and 	
	 Export Lists and Find Duplicate Names.

•	 Use the Export button to create a comma 	
	 separated file that can be opened in Excel to 	
	 use offline.

• 	 Start typing in any column’s top field to begin an 	
	 auto-sort based on what you are entering. This 	
	 easy-to-use functionality will allow you to easily 	
	 search and sort by names, grades and number of 	
	 times a student  is in the book.

•	 Use the green Merge button to merge two 
	 records. You can choose which name to keep 	
	 when you merge records. 
•	 Use the red Delete button to delete a record. 

•	 Use the Send Email button to send an email 
	 promoting your yearbook, Replay It, and ads. 

• On the Email setup page you will be asked what 	
	 product you would like to promote. Choose 
	 Yearbooks from the drop-down menu.

•  Choose the Selected Offering in drop-down 	
	 number two. 

•  In field three enter your school’s name exactly as 
	 you want it to appear in the email and subject line.

•  Click on the Next button and you will see a preview 	
	 of various email designs you can choose from. 	
	 Choose a design and cick Next. 

•  You can enter email addresses manually, copy and 	
	 paste them from a list you have, or click on the 
	 Address Book link to select addresses from the list 	
	 you uploaded. 

•  Click on the Send button to send your email.

Email Templates
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For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Creating Your Index

•	 Use the Settings tab to select the page you 	
	 would like to flow your index onto and set the 	
	 parameters or your index pages.

•	 Use the available menus to select the Name 	
	 Format, Divider and Body Fonts and Number 	
	 of Columns for your index.

•	 Edit the Margins to alter the layout of your 	
	 index. 
    Note: Be sure to leave adequate margin    	
   space at the top and bottom of your pages 	
   if you would like to add headlines, candid 	
   photos or stories. You can add these 
   elements in the Page Designer after you 	
   flow your index. 

•	 Click Preview to see how your pages will flow.

•	 Once you are satisfied with the preview use 	
	 the Save button to flow your index.

•	 You can edit your index by opening it up in 	
	 the Page Designer. 

Note: The indexing tool uses the information 
you entered in the Name fields in your Image 
Library to create your index. The name fields in 
the Image Library are set up so that entries are 
formatted correctly for placement in the index. It 
is important to keep the information in the Image 
Library up to date so that the index is correct.

Use the Jostens 
Online Index creation 
tool to quickly and 
easily create the 
index for your book. 

You can access 
the Indexing tool 
by selecting Index 
under the Create or 
Go To menu on your 
header.



Reviewing Your Pages Before Submission
•	 The Highlight Incomplete Elements tool, 
	 located under the Edit/Select/Incomplete 	
	 menu or on the Page Designer toolbar, 
	 will display possible problems such as text 	
	 that is too large to fit in the text box and 	
	 text/photo boxes that haven’t been edited.	 	

•	 The Highlight Incomplete Elements function 	
	 does not check content, spelling, photo 	
	 cropping, etc. It is important that you print 	
	 a PDF and review your page before 		
	 submitting it to the plant.

•	 Use the View PDF link under the File menu 	
	 to create a PDF of your page.

•	 To print a hard copy of your page, click 	
	 on the printer icon at the top of the Print 	
	 Preview PDF window, or select Print from 	
	 the File menu while viewing your Page 	
	 Preview.

When reviewing your page, check the 
following carefully:

1) Check all text for proper spelling, 
    punctuation and placement. 

2) Double-check the spelling and accuracy 
    of all names.

3) Check all photos for proper placement.

4) Print out a final copy of the page for your     	
   records prior to submission.
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For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Before submitting a 
page, do a complete 
review and carefully 
check for 
misspellings and 
incorrect photo 
placement. 
Correct any errors 
you find.  

Once a page has 
been submitted, it 
cannot be changed.
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Submitting Your Pages

For more detailed 
instructions and 
information click the 
Need Help? button 
along the top of your 
screen when you 
are working on your 
book online.

Before submitting a 
page, do a complete 
review and carefully 
check for 
misspellings and 
incorrect photo 
placement. 
Correct any errors 
you find.  

Once a page has 
been submitted, it 
cannot be changed.

•	 When you are working in your Page Ladder 	
	 (found under the Plan and Create menus), 	
	 you will notice the pages are color-coded to 	
	 indicate their status. You will also notice 	
	 when a page is in process, a Complete 	
	 button is available.

•	 The page status turns green after you click 	
	 the Complete button. You can only use the 	
	 Complete button after you have edited all of 	
	 the photo and text boxes on your page.
    Note: Use the Highlight Incomplete Elements 
	 functionality in Page Designer to see which 
	 elements you still need to edit on a page.

•	 After a page is marked as complete, you will 	
	 see two new buttons -- Submit and Return.
    Note: The Submit and Return buttons are 	
   only available to the Adviser login. If you 	
   decide the page still needs modification, 	
   simply select the page and make the  	
   changes. You also have the option to Return 	
   which requires the page to be set Complete 	
   again when you are finished with your edits. 

•	 Before you can submit your page you will 	
	 need to view the Proof PDF for final 	 	
	 confirmation that the page is correct. Click 	
	 on the printer icon on the Page Ladder to 	
	 generate the Proof PDF. Once you view the 	
	 PDF version of the page you will be able to 	
	 hit the Submit button.

•	 After you thoroughly review your page and 
    determine it is ready for submission, click on 	
	 the Submit button.
	 Note: Once you submit a page, you will 	
	 no longer be able to make changes to it. 	
	 Changes requested after submission can 	
	 result in extra charges. Contact your plant 	
	 consultant for assistance.

•	 Once a page has been submitted, it will 	
	 appear on your Page Ladder with black 	
	 color-coding. Submitted pages cannot be 	
	 changed.

	 You can also Mark Complete and Submit 	
	 your pages from the File/Page Info menu 	
	 link while viewing your page in your 
	 Page Designer.
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There are online 
resources available 
to help answer your 
Yearbook Avenue 
and YearTech Online 
questions. 

•	 Click on the Training button on your 
	 Yearbook Avenue Home Page to access a 	
	 variety of training videos. 

•	 Choose the video you would like to view 	
	 from the drop-down menu.

•	 Click on the Need Help link at the top of any 	
	 screen to access a wide variety of help 
	 topics available to view online and download 
	 as PDFs.

Online Resources

You can also contact the Jostens Technical Support team with your questions. 

Technical Support

PHONE
	 USA:  (800) 328-2435 			 
	 Canada:  (800) 665-7597 

EMAIL
	 ybasupport@jostens.com


